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Operating Checklist for using the Scanning Electron

Microscope ,  JEOL JSM 6400

Pre-Check

- Check logbook

- Check vacuum (10 - 7 range)

Specimen Insertion

- Check stage controls:

WD (working distance) 39 mm

X (direction) 25 mm

Y (direction) 35 mm

T (tilt) 0

R (rotation) 0°

- Insert specimen into holder with forceps and tighten screws

- Attach specimen holder to insertion rod

DO NOT TOUCH THE METAL INSERTION ROD

- Place rod with holder in port and press the Red Button on top

- Wait for the red light to go out before opening the Air Lock door

      To open the door:

Turn flat on the knob 90° towards you

Pull out till it stops

- Push rod in and secure holder on dovetail slide

- Unscrew rod CAREFULLY and retract fully

- Close airlock door by pushing in and turning the knob 90° to the ceiling

- Push Red Button while supporting the rod with your hand

- Remove the rod once the airlock has vented
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Startup

- Press FAST scan on the keyboard

- Turn up CRT1 (left) and CRT2 (right) using wheels located under screens

- Press ESC on keyboard to show cursor on CRT2 (ESC toggles cursor back and forth between

the screens)

- Press BREAK on the keyboard to show text (image settings) on CRT2. To remove text

(image settings), press BREAK again

- To set operating parameters:

Press PF-5 to show conditions 

Use arrows to highlight START UP

      Press L (load)

Press PF-2 followed by 1to show EOS-1 screen

Filament Saturation

- Press MODE button in panel 1to show scan line on CRT1

- Press the ACCEL VOLTAGE button (light should go on)

- SLOWLY turn up the EMISSION knob (clock wise) to saturate the filament. The line will

move up, drop down, move up and plateau (saturation).

- During saturation use BRIGHTness knob to center the scan line on the screen
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Beam Alignment

- Check gun alignment TILT / SHIFT button, light should be off

- Turn PROBE CURRENT up to 13 and use TILT control knobs (X and Y) to find the point of

maximal deflection

- Press TILT / SHIFT button, light should go on

- Drop PROBE CURRENT to 1 and obtain maximal deflection using SHIFT control knobs (X

and Y)

- Return PROBE CURRENT to 13 (SHIFT light turned off) and again maximize signal using

TILT control knobs

- Set PROBE CURRENT back to 7 (or otherwise if desired)

- Use FOCUS knob to adjust the scan line for maximum detail

- Use CONTrast  knob to adjust peaks and valleys (2 -3 cm amplitude)

- Use BRIGHTness knob to position the scan line mid-screen

- Press PIC button on panel 1 to show image

Check Alignment (optional)

- Recommended for high magnification and high resolution work:

- Press MODE on panel 1 one or more times to get cross-hairs

- Press ESC (cursor on CRT1) followed by BREAK to show image settings including a scale

marker

- Turn  MAGNIFICATION up to 5000X

- Run PROBE CURRENT from 13 to 1, shift should be less than one micron else repeat 'Beam

Alignment'

- When finished press BREAK  to remove image settings from CRT1

-  Press ESC to return to CRT2

- Press PF-2 followed by 1 to show parameters (EOS-1 screen) if not already there

- Press MODE one or more times to get scan line

- Press PIC button to show image
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Viewing

- Several adjustments to the image on CRT1 can be made:

- Use FOCUS knob to focus image, press FINE button for fine focussing ability (light should

go on)

- Use STIGMATOR knobs (X and Y) to correct for astigmatism

- Use knobs at the front of the specimen chamber to move the specimen:

X and Y (direction)

R (rotation)

T (tilt)

- Adjust magnification using MAGNIFICATION knob

- Press WFM to properly adjust contrast and brightness. (Use CONTrast and BRIGHTness

knobs to move peaks up to 2nd line from top and valleys about halfway between 2nd and 3rd

line from bottom. Turn off WFM)

- Use PROBE CURRENT knob to adjust condenser lens aperture

- To change working distance turn big knob on top of the specimen chamber

- To change accelerating voltage follow the instructions on 'Filament De-saturation', change

accelerating voltage using the knob right of ACCEL VOLTAGE button and re-saturate the

filament (see 'Filament Saturation')

- To change specimen follow the instructions on 'Filament De-saturation', 'Specimen Removal',

'Specimen Insertion' and 'Filament Saturation '

- Notice OPTimum APERture on EOS-1 screen. DO NOT CHANGE!
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Screen Text

- Press ESC on the keyboard to get cursor on CRT1 (ESC toggles cursor back and forth

between screens)

- Press BREAK to show text (image settings) on CRT1. To remove text (image settings), press

BREAK again

- To change existing text (image settings):

a) Use arrows to place cursor on JEOL

b) Press INS on keyboard

c) Type text up to 6 characters (CLS will remove INS effect)

d) Press ENTER

- To delete text (image settings):

a) Place cursor on block of text

b) Press ENTER

- To return text (image settings):

a) Place cursor on empty block

b) Press ENTER

- To move whole text (image settings), use arrow-keys on keyboard

- To write different information on CRT1:

a) Press BREAK and cursor will appear

b) Move cursor with arrow-keys to desired location

c) Type text (CLS will erase text)

d) Press ENTER

- To add text (image settings) to written information, press BREAK. To remove text (image

settings), press BREAK again
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Photography

Instrument setup

- Find specimen and focus (see 'Viewing')

- Press SCAN PIC button on panel 1 one or more times to focus on a brighter and smaller part

of your image:

Press IMAGE / POSITION button (lights on) to move frame over image using

knobs located left and right

Press IMAGE / POSITION button (lights off) to move image in the frame using

knobs located left and right

- Press D-MAG button on panel 1 to show actual size of the print. Turn off D-MAG

- Press WFM to adjust control and brightness (see 'Viewing' for detail). Turn off WFM

- To remove information temporary from CRT2:

a) Press ESC to get cursor or highlighted block on CRT2 (if not already there)

b) Press PF-1 followed by BREAK

c) To get information back, press PF-2 followed by 1

Film insertion

- Two types of Polaroid film (4 X 5 inches) can be used:

a) Type 52: delivers a positive print only

b) Type 55: delivers a positive print and a negative

- Push lever on film holder (Model 545) to the right (L) position

- Slide film all the way in (camera side down) until a "click" is heard

- Pull cardboard cover back as far as it will go

- Be sure f-stop setting is at f16 for type 52 film or f5.6 for type 55 film (dark red knob right of

film holder)

- Press LEFT button on panel 1 to begin the super slow scan for taking a picture. When

finished CRT goes back to rapid scan mode

- Push cardboard sleeve all the way back into film holder

- Pull lever on film holder to the left and pull the film smoothly out of the film holder
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Photography - continue:

Film processing

Type 52

- Develop film for 15 seconds (start as film leaves the film holder)

- Peel off paper covers

- Use special Coater to coat the print as soon as possible. DO THIS ON PAPER TOWEL,

NOT ON CONSOLE OF INSTRUMENT!

- Dispose film pack and used up Coaters properly

Type 55

- Develop film for 20 seconds (start as film leaves the film holder)

- Open pack and separate print from negative quickly and carefully. BE CAREFULL NOT

TO TOUCH THE SURFACE OF THE NEGATIVE

- In warm water, fold ends of negative and tear them away. Discard the tabs

- Swirl negative in warm water to cause the developing layer to drop off

- Rinse for at least 5 minutes in warm water

- Dip negative in wetting agent solution and hang up to dry

- Use special Coater to coat the print as soon as possible. DO THIS ON PAPER TOWEL,

NOT ON CONSOLE OF INSTRUMENT!

-  Dispose film-pack and used up Coaters properly
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Digital Image Capture

- If computer is not ON, turn ON computer. Turn ON monitor and printer

- Load ISIS by clicking on ‘Link ISIS’ icon or select ‘Link ISIS’ from the ‘Start’ menu

- After a message about ‘Resetting Hardware’, a Welcome Window will appear

- Choose an ‘operator’, which will ordinarily be you or the name of a course (SEM interterm)

- Click on the blue ‘Labbook’ button to get the ‘Labbook’ window

- To obtain an image with correct scale-bar:

- Select the ‘X-Ray Analysis’ button (first button from left) in the ‘Labbook’ window

- Select the ‘Microscope’ button (bottom right) in the ‘X-Ray Analysis’ window

- Click on the ‘magnifying glass’ button, enter the working magnification (see SEM

monitor) and select ‘OK’. Every time you change the working magnification on the SEM

you need to adjust the magnification in the ‘ISIS’ program before acquiring an image

- Go back to the ‘Labbook’ window by selecting ‘Labbook’ from the menu bar

- Select the ‘Autobeam’ button (second from left) in the ‘Labbook’ window

- Go to view in the ‘Autobeam’ window and select ‘Scale Marker Bar’ from the dropdown

menu. This should be checked off

- To obtain an image without scale-bar:

- Select the ‘Autobeam’ button (second from left) in the ‘Labbook’ window

- Go to view in the ‘Autobeam’ window and make sure the ‘Scale Marker Bar’ from the

dropdown menu is NOT checked off

- To acquire an image, click on the round ‘Start’ button on the upper left of this window. This

digital image will improve by averaging over time

- To stop acquiring an image, click the square ‘Stop’ button next to the ‘Start’ button

- To change image size and detail (# of pixels) as well as the speed of acquisition, select

‘Image setup’ from the ‘Edit’ menu

- To adjust contrast and brightness, click on the third button from left in the ‘Autobeam’

window

- To save an image select ‘Export as a TIFF’ or ‘Export as a BMP’ from ‘File’ menu. Drive ‘d’

is for ZIP disk

- To print an image, select ‘Print’ from ‘File’ menu

- When finished close all windows (including ‘Labbook’ window) to log OFF



9

Filament De-saturation

- SLOWLY turn EMISSION knob all the way down (counter clock wise)

- Press ACCEL VOLTAGE button (light should go out)

Specimen Removal

- Check stage controls:

WD (working distance) 39 mm

X (direction) 25 mm

Y (direction) 35 mm

T (tilt) 0

R (rotation) 0°

- DO NOT TOUCH THE METAL INSERTION ROD

- Place rod in port and press the Red Button on top

- Wait for the red light to go out before opening the Air Lock door

      To open the door:

Turn flat on the knob 90° towards you

Pull out till it stops

- Push rod in and contact specimen holder

- Screw rod in and pull rod and holder out

- Close airlock door by pushing in and turning the knob 90° to the ceiling

- Push Red Button while supporting the rod with your hand

- Remove the rod once the airlock has vented

- Remove specimen holder from insertion rod

- Loosen screws and remove specimen from holder with forceps
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Shut Down

- After 'Filament De-saturation' and 'Specimen Removal':

- Turn electronics of the microscope to the proper shut-down position:

Press PF-5 to show conditions 

Use arrows to highlight SHUT DOWN

      Press L

- If image settings show, press PF-1 followed by BREAK to remove data on CRT2

- Press ESC to move cursor from CRT2 to CRT1

- If there is information on CRT1, press BREAK (only cursor in left corner is shown)

- Turn down CRT1 and CRT2

- To reduce use of scan coils, press SLOW scan on the keyboard twice. A scan line will appear

- Use BRIGHTness knob to reduce the brightness of the scan line

- Sign out Logbook

- Leave room CLEAN and TIDY!
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ATTACHMENT 1:

Critical Point Dryer

1. Turn power switch ON and make sure the hood fan is ON

2. Ensure that all three valves are closed

3. Fill chamber with 100% EtOH and transfer specimen(s) into chamber

4. Put the lid on the chamber, tightening all three screws evenly

5. Open tank valve, allowing CO2 into pipes

6. Open the cool valve, allowing the temperature to drop to about 5 ºC

7. Close cool valve

8. Open the inlet valve

9. Allow chamber to fill for about 3 minutes (set timer)

10. Open the exhaust valve slightly, purging the chamber for 30 seconds

11. Close exhaust valve

12. Repeat purging procedure (step 9-11) five times. Use pennies to keep track

13. Open the exhaust valve slightly and use a Kimwipe to confirm (smell) that there is no EtOH

left

14. Close the exhaust valve, close the inlet valve, close the tank valve, and open the cool valve to

drain the line. Close the cool valve

15. Turn on the heat switch, allowing the temperature to rise to about 40 ºC, at which the

indicator light will go out. During this time, if the pressure in the chamber rises above 1400

psi, open the exhaust valve very slightly to minimally decrease the pressure to below 1400

psi

16. When the heat indicator light goes out, vent the chamber by opening the exhaust valve very

slightly. Use a container with water to check the exhaust speed (separate air bubbles). The

pressure must be decreased to zero slowly!

17. Remove the camber lid and your specimen(s)

18. Make sure that all switches are turned OFF and that the lid is re-secured before you leave

19. Sign out ‘Critical Point Dryer Logbook’
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ATTACHMENT 2:

Sputter Coater

Sample insertion
1. Lift the lid off the vacuum chamber
2. Carefully remove the glass cylinder and lay it on its side where it won’t roll off the counter.

This prevents messing up the vacuum grease on the top and bottom rims
3. Place your specimens on the central area of the pedestal, not the raised ring around the

periphery
4. Replace the glass cylinder and close the lid

Control vacuum
1. CLOSE the vent toggle valve (down)
2. CLOSE the increase/decrease needle valve (clockwise). Be sure the high voltage control

switch is OFF and the high voltage dial is at O
3. TURN the main power switch ON
4. Wait 15 – 20 min. to create a vacuum in the vacuum chamber
5. OPEN the increase/decrease needle valve (3 full turns counter clockwise) to increase the air

flow in the vacuum chamber

Coating
1. High voltage switch should be OFF; set high voltage dial to 9
2. Press the high voltage switch ON
3. Allow about 10 seconds for the instrument to stabilize and the vacuum chamber to outgas
4. Use the needle valve to ADJUST the current so that the current meter reads 10 milliamps:

- if the current is to high, turn the needle valve toward decrease (clockwise)
- if the current is to low, turn the needle valve toward increase (counter clockwise)

5.   Coat specimens for 2 to 3 minutes
6. While coating, touch up the current flow if necessary, to keep the meter at 10 milliamps
7. After coating, turn high voltage switch OFF and set dial back to 0

Sample removal
1. TURN main power OFF
2. Immediately OPEN the air inlet toggle valve (lift)
3. Open the lid
4. Remove the glass cylinder (lay it on its side where it won’t roll)
5. Remove your specimen to a safe storage container

Shut down
1. CLEAN THE CYLINDER inside with a paper towel wet with absolute EtOH or acetone
2. Check that the vacuum seals are clean and greased and reassemble the machine
3. Do not pump down, leave it under atmospheric pressure, close increase/decrease needle valve

(clockwise)
4. Sign out ‘Sputter Coater Logbook’
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